
SYSERR Window and Functions
From the SYSERR window, you can invoke all commands and functions available for maintaining user-defined or
Natural system messages. 

The SYSERR window is divided into two sections that contain data on messages available in the current library:

The left section with a list box displaying all messages available for the current language. 
The right section displaying the fields with the text of the current message. The current message is the message
selected (highlighted) in the list box.

If no message exists for the specified library, both sections are empty.

The SYSERR window provides menus and command buttons for executing SYSERR functions and commands. As
an alternative to menus and command buttons, you can execute most of the functions and commands with the
buttons of the toolbar.

There are context menus available for several elements in the list box and the dialog boxes provided with the
SYSERR functions. To invoke the context menu for an element, click the element desired with the right mouse
button or select the element and press SHIFT+F10. The available commands are either cut and paste functions or
correspond to the commands in the menus or to command buttons.

This section covers the following topics: 

List Box 
Fields 
Command Buttons 
Menu Bar 
Toolbar 
Status Bar

List Box
The list box appears in the left section of the SYSERR window. It contains the short messages of one language for
one library. The short texts are preceded by the message number. The messages are sorted by the message number in
ascending order.

If  a message file contains more than 200 messages, for performance reasons, not all messages are read in one step.
When initializing the SYSERR window, up to 200 messages are read from the message file at once, and about 30 of
them are displayed in the list box. Scrolling down the list with the vertical scroll bar, the next 200 messages are read
and displayed as soon as the scroll bar reaches the bottom of the list box.
Choose the Read All menu option, to read all remaining messages in one step as described under Edit Menu.

The selected (highlighted) short message is the current message. It is displayed on the right side of the SYSERR
window. There, you can modify the short and long text. See also Fields below.

Fields
The following fields appear in the right section of the SYSERR window:
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Field Explanation 

Samp. Output field that appears above the Num. field if a sample message exists for the current language and 
library.
Samp. displays the text of the sample message. 

To create and use a sample message, see Sample under Options Menu. 

Num. Displays the number of the current message. It  corresponds to the selected message in the list box. 

To display another message or to create a new one, replace the current number by another valid number. 

The maximum message number for a library and language is 9999. The message number 0000 is not
allowed. 

Short Modifiable field displaying the short message text of the current message number. 

The input of the short message is mandatory. A new message can only be saved if text has been entered in
the Short field. Therefore, if no text is displayed for the current message, the message number is free and
can be assigned to a new message.

To extend the default field length, see Short Message Length 72 under Options Menu.

To copy sample messages into the Short field, see Sample under Options Menu and Copy under Command 
Buttons.

To copy text from the Short to the Long field, choose the command button Short to Long.

Long Modifiable fields displaying the long message text of the current message. 

Long consists of three input areas:

Text Extended version of the short message text. 

Expl. Further explanation of the message. 

Action  The action to be taken to resolve a problem, if relevant. 

The input in Long is optional.

To copy text from the Short to the Long field, choose the command button Short to Long.

Command Buttons
The following commands can be executed by using command buttons:
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Command Explanation 

Copy This button is only visible if a sample message exists for the current language and library. Copy
appears under the toolbar, in the right upper section of the SYSERR window.

Copies the text of a sample message (see Sample under Options Menu) into the Short field (see
Fields) of the current message. 

Previous / Add
Previous / Update

Toggles between Previous and Add, and Previous and Update depending on the status of the
current message: 

Previous  Scrolls from the current message to the previous message if no modification was
made. 

Add Adds a new message to the message file. 

Update Saves the current message to the message file after modification. 

Note: You can only save a message if text was entered in the Short field (see Fields).

Next / Reset  Toggles between Next and Reset, depending on the status of the current message: 

Next Scrolls from the current message to the next message if no modification was made. 

Reset  Resets modifications made to the current message and displays the original
message. 

New Searches for the next free message number starting from the current message, and opens input
fields to create a message for the number found. Free means that this message number is
available and has not been assigned to another message of any language. 

The search direction is downwards by default. However, the default direction can change to
upwards if a previous search was performed in an upward direction by using the alternative
function New Message (see Edit menu). 

Upwards searches for the next lower message number, downwards searches for the next higher
message number from the current message. 

As an alternative to New or New Message, you can also create a new message by replacing the
number in the Num. field. 

Short to Long Copies the text of the Short field to the first line of the Long field. 

Menu Bar
The functions and commands available on the SYSERR menus are described below. Some menu items are used to
switch between modes or set a status. The check mark next to a menu item indicates which mode or status is active.

The section below contains information on: 

File Menu 
Edit Menu 
View Menu 
Options Menu 
Help Menu
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File Menu

Function Explanation 

New 
Lib/Lang

Only applies to libraries and languages for which no messages exist.

Opens a new library and/or adds a new language. See also To switch libraries and/or languages 
below.

Open 
Lib/Lang

Only applies to libraries and languages for which messages already exist.

Opens another library and/or changes the language.

See also To switch libraries and/or languages below.

Open File This function does not apply for accessing data on mainframe servers.

Selects an existing message file from a Natural Err directory (FNAT or FUSER) or from another
directory. 

See also the section Generating Message and Text Files.

Print Invokes the print function.  

A dialog box prompts you to:

Enter the range of messages. 
Mark the Long Texts printout option if you want to print the long message in addition to the
short message. 
Specify layout parameters and select the output device: Printer or Source. The initial assignment
is the default printer set by Windows.
If you choose Source, the output will be routed to your source work area.
To display the output in the source work area, use the system command LIST. If desired, use the
system command SAVE and the Natural object type Text to save the contents of the source work
area. 

To print all Natural system messages

1.  Perform the steps described in Invoking SYSERR for Natural System Messages in the section
Invoking SYSERR. 

2.  From the File menu, select Print. 

Exit Exits SYSERR. 

 To switch libraries and/or languages

1.  From the File menu, select New Lib/Lang if not messages exist.
Or, from the File menu, select Open Lib/Lang if messages exist. 

2.  The New Lib/Lang or Open Lib/Lang dialog box similar to the example below appears: 
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3.  From the Library drop-down list box, select a library and a language.
In the example above, the new Language Code 6 (Dutch) is selected for the library TESTLIB. TESTLIB
already contains messages but no messages of Language Code 6. 

4.  Choose the OK button to confirm your selection. 

An empty SYSERR window appears for the specified library and language.

Or, if the Open Lib/Lang menu option was selected, a list of messages appears that exist for the specified library
and language.

Edit Menu
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Command  Explanation 

Cut Supported clipboard functions. 

Copy 

Paste 

Undo Standard edit functions. 

Delete 

New Message Searches for the next free message number starting from the current message, and opens input
fields to create a message for the number found. Free means that this message number is available
and has not been assigned to another message of any language. 

Upwards/Downwards: specifies the search direction. Upwards searches for the next lower
message number, downwards searches for the next higher message number from the current
message. See also the alternative New command button.

As an alternative to New Message or the New command button, you can also create a new
message by replacing the number in the Num. field.

Delete SelectedRemoves all messages selected (highlighted) in the list box. A dialog box prompts you to confirm
the action. 

Delete All Removes all messages displayed in the list box. A dialog box prompts you to confirm the action. 

When all messages of a message file have been deleted, the message file is deleted too. 

Read All Reads all messages from a message file into the list box in one step. This command applies to
message files with more than 200 messages. 
Otherwise, for performance reasons, only 200 messages are read by default when the SYSERR
window is started. Additional messages can be displayed by scrolling down the list box to the end
or by using the Read All menu option. 

Translate Supports the creation of messages for different languages. Applies to short messages only. See To
translate languages below.  

 To translate languages 

1.  From the Edit menu, choose Translate. 

The Select Languages dialog box opens:

2.  Select one language or more into which you wish to translate the current message and choose the OK button. 
3.  The Translate dialog box similar to the example below appears: 
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The Translate dialog box always lists the current language of the short text (here: English) in the first position
followed by the new language(s) selected in Step 1 above. 
The Translate dialog box provides the following menu options, commands and fields:

Commands/Fields Explanation 

File menu: Exit Closes the Translate dialog box and returns to the SYSERR window. 

Options menu:
Select Languages

Invokes the Select Languages item from of the Options menu to add additional languages
unless selected earlier, during Step 1 above. 

Available 
languages

The language code(s) of the language(s) already available for the current message
number.  

Language
The code and language of the current language and the new language(s) selected.
The current language is always listed in the first position. 

Short Text The text of the short message. 

Previous/Update Same as described for Previous/Update under Command Buttons. 

Reset/Next Same as described for Reset/Next under Command Buttons. 

Help menu: 
SYSERR Help

Display SYSERR help text. 

4.  Enter the translation in the Short Text field of the relevant language(s). 
5.  Choose Update.

The language code(s) of the new language(s) appears under Available Languages.
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View Menu

Function Explanation 

Languages 
Display

Provides an overview of all available languages for one message number. You can choose among
the following views:

Compressed  Displays the language code(s) that exists for a short and long message. For short
messages, the language codes are listed next to Short, for long messages next to
Long. 

See also Example of Compressed below. 

Extended 
Short

Displays the language code(s) that exists for a short message next to the message
number. 

Extended 
Long

Displays the language code(s) that exists for a long message next to the message
number. 

You can keep the Languages Display dialog box open while maintaining messages, and use the
Reload command button any time you want to refresh the Languages Display.

Filter Display Applies in connection with the Set Filter function.

If Set Filter is enabled, the Filter Display function displays the short messages that match the
search criteria defined with the Set Filter function.
If Filter Display has been enabled, the search criteria specified with the Set Filter function are
displayed above the list box.
To disable the Filter Display and list all messages, again choose the Filter Display option from the 
menu.

Set Filter Specifies search criteria for selecting short messages, and displays the result in the list box. See
also To enable the Set Filter function.

Set Filter must be enabled in order to use the Filter Display function.

Example of Compressed
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In the example above, the short text (Short) for message number 14 exists in English = 1, German = 2, Spanish = 4,
and Italian = 5. The long text (Long) for message number 14 exists in English = 1.

 To enable the Set Filter function 

1.  From the View menu, choose Set Filter.
The Set Filter dialog box similar to the example below appears: 

The Set Filter dialog box provides the following options to specify search criteria:
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Option Function 

Filter values There are four fields available for entering search criteria. 

Or/And/Not You can include the conditional operands OR (default), AND or NOT between the search
items. 

If you only fill one of the Filter Value fields, the conditional operands are ignored.  

Find whole wordsIf marked (default), the search is restricted to match entire words only and not part of a
word. 

Case sensitive If marked, the search is restricted to letters that exactly match the lower and/or upper case
specified. 

In the example above, the search finds all short messages that contain both the words "buffer" and "pool". If the
operand NOT were specified, the search would find all short messages that contain neither the word "buffer"
nor the word "pool". 

2.  Enter search criteria and choose the OK button.
If the search criteria entered match word(s) contained in the short message(s), the matches are displayed in the
list box and the Set Filter and Filter Display functions are enabled. 

3.  To remove a filter and list all messages, choose Filter Display to disable the function.

If the Set Filter function is enabled, alternatively, you can execute the filter function with the Filter Display function.

Options Menu

Function Explanation 

Sample Invokes the Maintain Sample Message dialog box where you create a sample message to be used as
a master for creating new short messages or replace the text of existing short messages. 

If you enter the string 0000 anywhere in the Maintain Sample Message dialog box (combined with
text or not), the string 0000 is replaced by the number of the new message or the current message
when copying the message. 

You can define one sample message for each language and library. 

If a Sample message was created, the Samp. field appears with the text of the sample message.

To copy the text of the sample message into the Short field, use the Copy command button (see
Edit Menu). Alternatively, you can enter .C in the Short field if this field is empty. 

Layout See Layout below. 

Shift Short 
Left

If enabled,  automatically shifts the text of a short message to the left margin when adding a new
message or choosing the Update command button after modification. 

Short
Message
Length 72

This function is not relevant for data accessed on UNIX or mainframe servers.

If enabled, the Short field (see Fields) is extended to a maximum input of 72 characters. The
default field length is 65 characters, which is the maximum input in UNIX and mainframe 
environments.

Size Startup Resizes the dialog box to the size it had at startup. 

Full List Box  Resizes the dialog box to display the short message in full length. 
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Function Explanation 

Confirm 
Window

Enables/disables a pop-up window to confirm: 

The new message number. 
That the text of the short message is copied into the first line of the Long field if  Short to 
Long was chosen. 
That the text of the sample message (if available) is copied to the Short field if Copy was
chosen. 

Import Text 
File 

This function does not apply for accessing data on mainframe servers.

Imports a text file and converts it into a message file. Note that you always need to specify the full
path of a file.

For further information on file formats and how to recreate a text file, see the section Generating
Message and Text Files. 

From
(text file)

 The name of the text file from which the message file will be generated.

To
(message file)  

 The name of the message file into which the text file will be generated.
Default is the full path name of the current library and message file. 

For user-defined messages, the file name must be NnnAPMSL.MSG. 
For Natural system messages, the file name must be NnnLmmmm.MSG. 

Export
Message File

This function does not apply for accessing data on mainframe servers.

Exports a message file and converts it into a text file. Note that you always need to specify the full
path of a file.

For further information on file formats and how to recreate a text file, see the section Generating
Message and Text Files. 

From
(message file)  

 The name of the message file from which the text file will be generated.
Default is the full path name of the current library and message file.
For user-defined messages, the file name must be NnnAPMSL.MSG For
Natural system messages, the file name must be NnnLmmmm.MSG. 

To
(text file)

 The name of the text file that will be generated. 

Layout

The Layout option allows specification of valid message ranges to categorize messages. Overlapping of ranges is
possible. A new message can only be added if its number is within the range defined in the layout.

The layout definition applies to all languages. It is stored in the English message file.

An example layout definition is shown below: 
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In the fields From and To, specify the message range. In the field Description, enter text that describes the message 
category.

To insert or delete rows, mark a row and press the insert or delete key. If the maximum of 18 rows is displayed, you
may have to delete or overwrite another row before you can insert a new one.

Help Menu

Displays SYSERR help text.

Toolbar
The toolbar buttons represent the following menu commands or command buttons: 
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New Library/Language (File menu) 

Open Library/Language (File menu) 

Print (File menu) 

Exit SYSERR (File menu) 

Cut (Edit menu) 

Copy (Edit menu) 

Paste (Edit menu) 

Undo (Edit menu) 

New Message upwards (Edit menu) 

New Message downwards (Edit menu) 

Read All (Edit menu) 

Translate (Edit menu) 

Filter Display (View menu) 

Previous (command button) 

Next (command button) 

Update (command button) 

Reset (command button) 

Sample (Options menu) 

Layout (Options menu) 

Size Startup (Options menu) 

Import Text File (Options menu) 

Export Message File (Options menu) 

Status Bar
The status bar on the bottom of the SYSERR window displays: 

The total number of messages that exist in the specified library for the current language, the possible message
range 1 to 9999, and the last message number used.
This information is only displayed when initializing SYSERR, opening another library or when using the Read 
All  menu option described under Edit Menu. 
Natural System Messages or the ID of the current library. 
The code and name of the current language.
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